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This page contains Cobol Tutorial, Cobol Tips, Cobol Manual Cobol (Business Common Oriented Language) - a high-level language, based on English, which is mainly used for business applications. Most IBM installations use COBOL as the main language. Most important COBOL connections and useful connections are provided below. If you have all
links, cobol or tutorial manuals. Transmits them to the webmaster to srcsinc@yahoo.com Last update This page on April 27th 2003, one 42English (United Kingdom) A ¢ 4—a 42English (United States) A ¢ A—a ASpaAf A A + OL (LatinaamAf A © Rica) A ¢ 4— Tutorial for CSIMPAPPP, a simple application COBOL This topic includes the following sections:
A ¢ ¢ Preparation CSIMPAPP File and resources Af ¢ Phase 1: How to copy the CSIMPAPP file A ¢ & ¢ Phase 2: exam and compilation of a client & ¢ phase 3: exam and processing of servers a ¢ step 4: Edit and uploading the configuration file A ¢ & ¢ phase 5: How to start an application A ¢ Step 6: as proof The Run-Time Application A ¢ A ¢ Step 7:
How to monitor the runtime application & ¢ Step 8: How to turn off the CSIMPAPP application is a basic sample ATMI application supplied with the Oracle Tuxedo system. While instructions are written for the Cobol Microfocus compiler, they may vary depending on the compiler specification. To find out which COBOL platforms are supported by the
Oracle Tuxedo system, see Appendix A, A Oracle Tuxedo 10.0 Platform cards, A, in installing the Tuxedo Oracle system. CSIMPAPP includes a client and a server. The servers perform only one service: you accept a string from the client and returns the same string in uppercase. Click any task for instructions on how to complete this task. Figures, 44,
development process 1 csimpapp 1. Make a directory for csimpapp and modify the directory to it: mkdir csimpdircd csimdir 2. set and export environment variables: tuxdir = appdir = = $ Tuxconfig AppDir / TuxConfigCoBDIR = COBCPY = $ TuxDir / COBincLudecObopt = "- C ANS85 -C ALIGN = 8 -C NoiBMCOMP -C TRUNC = ANSI -C -C Osext = cbl
"cflags =" - i $ tuxdir / includes "path = $ tuxdir / bin: $ appdir: $ pathld library path = $ cobdir / coblib: $ {ld library path} export tuxdir appdir tuxconfig ubbconfig cobdir cobcpyexport cobopt cflags path Id library path is needed Tuxdir and route can access the files in the Oracle Tuxedo directory frame and execute Oracle Tuxedo commands: A ¢
4 ¢ on Sun Solaris, / USR / 5Bin must be the first directory in the path. 3. CP Tuxdir / samples / ATMI / CSIMPAPP / *. The files that make up the application are: A ¢ & ¢ csimpcl.cblA ¢ The source code for the client program. A, & ¢ csimpsrv.cblA ¢ The source code for the server program. A, ¢ TPSVRINIT.CBLA ¢ The source code for the server
initialization program. A, ¢ ¢ ubccsimpleA ¢ The form of the text of the configuration file for the application. A, ¢ WUBBCSIMPLEA ¢ The configuration file for the workstation example. A, ¢ WSA a directory with .mak files for client programs for three workstation platforms. Review the source code of the client program: the output is shown in the
following list. Listing, 4th, 1 source code for CSIMPCL.CBL 1. Run BuildClient to fill out the ATMI client program: BuildClient -C -O CSIMPCL -F CSIMPCL.CBL The output file is CSIMPCL and the input source file is CSIMPCL. CBL. $ LS CSIMPCL * CSIMPCL CSIMPCL.CBL CSIMPCL.IDY CSIMPCL.INT CSIMPCL.O You now have an executable
module called CSIMPCL. A ¢ ¢ BuildClient (1) in Oracle Tuxedo command reference A ¢ & ¢ Tpinitialize (3CBL) in the function of Oracle Tuxedo ATMI COBOL reference to a TPTerm (3CBL) in the Oracle Tuxedo Atmi Cobol function reference to an A ¢ (3CBL) In the Oracle Tuxedo Atmi Cobol function reference to a ¢ UserLog (3CBL) in the Oracle
Tuxedo Atmi Cobol function. Reference 1. Review the source code from the CSIMPSRV ATMI server program: Listing, 44, 2 source code for CSIMPSRV. CBL Listing, 44, 3 The source code for TPSVRINIT.CBL 1. Run BuildServer as follows to complete the ATMI ATMs program. You now have an executable module called CSIMPSRV. A ¢ A ¢ buildserver
(1) in Oracle Tuxedo Command Reference A ¢ A ¢ TPSVCSTART (3cbl) in Oracle Tuxedo function ATMI COBOL reference to a A ¢ TPSVRINIT (3cbl) in Oracle Tuxedo function ATMI COBOL reference to a A ¢ TPRETURN (3cbl) in the Oracle Tuxedo ATMI COBOL function reference to a A ¢ Userlog (3cbl) function in Oracle Tuxedo ATMI COBOL
reference ListingA 4A configuration file 4 CSIMPAPP * MACHINESDEFAULT: APPDIR = " "TUXCONFIG =" "TUXDIR =" "envfile =" "# Example: # APPDIR ="/ home / me / simpapp "# TUXCONFIG ="/ home / me / simpapp / TUXCONFIG "# TUXDIR ="/ usr / tuxedo "envfile # = / home / simpapp / envfileA ¢ I / LMID = 2. For each simple string
(namely, for each string shown in italics in angle brackets), substitute an appropriate value: A ¢ A ¢ IPCKE YA ¢ use a value that will not conflict with other users. A ¢ A ¢ TUXCONFIGA provide the full path of the binary TUXCONFIG file. A ¢ A ¢ TUXDIRA the full path to the root of the Oracle Tuxedo system. A ¢ A ¢ APPDIRA the full path of the
directory where you want to start the application; in this case, the current directory. A ¢ A ¢ ENVFILEA the full path to the environment file to be used by mc, viewC, tmloadcf, and so on. A ¢ A ¢ machine-NAMEA the name of the machine, as returned by the uname -n command on a UNIX platform. Note: The paths for TUXCONFIG and TUXDIR must
be identical to those you set and exported earlier. You must specify the names of the actual paths; references to paths through environment variables (such as TUXCONFIG) are not acceptable. Do not forget to remove the angle brackets. 1. Run tmloadcf to load the configuration file: A ¢ A ¢ tmloadcf (1) in Oracle Tuxedo reference command A ¢ A ¢
UBBCONFIG (5) in file formats, data Descriptions, MIBs, and system processes reference Run tmboot to bring up the application: A ¢ A ¢ tmboot (1) in Oracle Tuxedo reference command tests for CSIMPAPP, the client send a request: $ CSIMPCL a hello worlda ¢ HELLO WORLD tmadmin can interpret and execute more than 50 commands. For a
complete list, see tmadmin (1) in Oracle Tuxedo Command Reference. The following shows two of the many tmadmin commands: 1. Enter the following command: The following lines are displayed: Note: The greater than sign (>) is the tmadmin prompt. 2. Insert the print server command (PSR) to display information about servers: 3. Enter
Printservice control (PSC) to view information about the services: 4. Leave tmadmin by entering a q at the prompt. (You can start and stop the application from within tmadmin.) A A ¢ tmadmin (1) in tmshutdown Oracle Tuxedo Command Reference 1. Run to break down the application: Each line of the ULOG for this session is significant. First look at
the size of a ULOG line: Now look at a royal line. 140542. Message TPSVRINIT in CSIMPSRV A ¢ A ¢ tmshutdown (1) in Oracle Tuxedo reference command A ¢ A ¢ Userlog (3cbl) in the reference function of Oracle Tuxedo ATMI COBOL This tutorial guides you through the steps to create your first Hello world COBOL application and demonstrates the
basic features of the Visual Studio integrated development environment (IDE). Create a project to start the Visual Studio IDE: Windows 7 and earlier versions of the Windows desktop, click Start> All Programs> Micro Focus Visual COBOL> Visual COBOL for Windows Visual Studio 2013. 8.1 From the start screen Windows, click the visual COBOL for
visual Studio 2013 tiles. Windows 10 and later from the Windows desktop, click Micro Focus Visual Cobol> Visual Cobol for Visual Studio 2013. If this is the first time you start Visual Studio on your computer, you are asked to specify the default settings of environment. Choose General Development Settings. The windows can be opened in Visual
Studio and their arrangement depend on the fact that the IDE was used before and on the edition edition Visual Studio you could have installed on your machine. You can move, resize and minimize windows and that's why it can't appear exactly as described here. You can see: the home page that you can close. The window explores solutions, which
gives a direct view of what is on the disk for your solutions. A solution represents a position for projects related to the solution. For example, the solution you are about to work with contains two projects - a batch project and an online project. At the bottom right is a window of the properties showing the properties of the selected element in Solution
Explorer. Output window - Displays the results of tasks and for compiling applications. Windows list error - View details on any errors that may be present in the code. Project details Window that gives a logical view of your COBOL application. The main activity window at the top IDE, the editor, is where you can change or debug the sources. This
window is empty. In addition to the menus, there are a series of buttons in the toolbar, which vary depending on what is being done with the IDE. Experiment with resizing, minimizing and restore windows. To move a window: Click on the window title bar. Holding the mouse on the window title, drag the window to the left and down. Note: If you close
a window, you can restore if from the View menu. If you want to restore the default Windows Layout settings of the IDE, click. In Visual Studio, click. In the New Project dialog box, expand. Select Native. In the central pane, select Console Application. Specify a name for the project as well as Hellocobolworld, specify a location, if necessary, and click
OK. This creates a solution (which is a project container), and a project with a skeleton COBOL program. The solution and the project are displayed in the Vista Explore solutions. The program is loaded into the Visual Studio editor. To demonstrate how new files are created in a project, you are going to create a new source file that will control the
source code for the Hello World Cobol application: right mouse button The project in Explorer solutions and click Add> New item. In the Add new item dialog box, make sure the COBOL program is selected. Specify a name like HELLOWORLD.CBL and click Add. This creates the file in the project and opens the editor. You can delete the skeleton
program that has been created when the project was created - Right-click Program1.CBL in the Solution Explorer project, then click Delete. Confirm that you want to delete the file. In the code within the new file, go to the line that contains a procedure division. where you need to add the executable instructions. Place the cursor at the end of the line
and press Enter. This creates a new row in the file and the cursor is positioned immediately after the gray margin area in the AB area. By default, the COBOL editor is configured for intelligent editing and does not position the cursor in COBOL margins areas. Type the code to write text in the console: 'l Hi CoBOL WORLD 'display. Click File> Save
everything. Now that you added some code that can be performed, you can build your project. Because this is a project that creates a console application, building will produce an executable file in a subfolder of the project that is specified in the properties of the project. To build the application: Select the solution in Solution Explorer and choose
Generate> Generate solution. The project generation process is displayed Output window. This proves that the construction has succeeded and where the executable file is. If there were problems with the compilation, the IDE displays the error list window. You can open these windows manually from the View menu. The project has been successfully
built so you can now run the application. To run the application from Visual Studio: Click Debug> Start without debugging. A command window opens showing Hi Cobol Mondo. Press any key to close the console. Retains preserves Solution and project because you will use it again for a different demonstration included in this introduction. Continue
with the next tutorial, configuring the Hello Cobol World application, which shows how to configure a project to locate copybooks that are not in the project directory. Directory.
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